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1  Overview
SonicStudio•DDP is an easy to operate, task-specific tool for working with DDP 
image files.

 SonicStudio•DDP is ideal for:

1) auditioning the audio in a DDP image

2) checking the locations of the PQ marks relative to the sound

3) verify metadata associated with a title

SonicStudio•DDP allows you to audition and edit your DDP image without the need
to tie up an expensive, DAW-based production system. You could, for instance, use
SonicStudio•DDP to do a final check for imperfections in a program before the title
goes out for replication. Marks can be added, deleted or moved in time, while ISRC
entries and UPC/EAN values can be verified and edited if necessary. Also, since it
runs on any Apple CPU, including a laptop, it is highly portable.

1.1  Workflow

When you open a DDP image into SonicStudio•DDP, you are creating a copy of the 
image in memory that you can manipulate. This copy is called a Project.

Within the Project, you can edit marks that generate PQ codes, and you can also 
place editing marks inside the waveform as well. This information can be saved 
and recalled later by selecting File > Save Project.

◊ Note – None of your changes to the Project are saved to the DDP image until 
you intentionally write your changes back to the image file. This is done by perfo-
ming a "Delivery" (see section 3.7, PQ Delivery tab of the Mark Info window).
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2  The Main Screen
Figure 1 shows the main screen of SonicStudio•DDP.

Figure 1 – The main window

The bottom of the screen shows the waveform display for the two tracks of audio. 
The upper waveform shows the left channel, and the lower waveform represents the 
right channel.

Immediately above the wavefoms is a black banner. At the top of the black area is 
the timeline for the waveform display. At the bottom of the black area are any placed 
PQ marks.

To the left of each track are solo and mute buttons, labeled with an S and M respec-
tively, along with a amplitude meter. At the top of the main screen are time displays, 
for the playhead and for edit locations.
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3  Quick Start
This section tells you how to use the most basic operations so you‘ll be up and run-
ning right away. Soon, you will want to start learning the enhanced features (see 
section 4, Menus).

3.1  Opening A File

3.1.1  Opening a Project or DDP Image

To open either an existing SonicStudio Project or DDP Image File Set, select File >
Open Project… or Open DDP Image… and choose a Project file or folder containing
a DDP image set in the resulting file browser. If waveforms are absent from the
Project or DDP image, the application will begin the process of building waveform
or “reduce” files in the background.(see Figure 2).

Figure 2 - Waveforms being built in the background

These new files, with a “.r” suffix, will be placed in the same folder as the parent
sound files. Waveform display provide visual reinforcement to audible cues when
editing.
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3.2  Auditioning Sound

3.2.1  Playback

When you press the Space Bar, the cursor changes to a speaker & note as play-
back will start. A veritcal red line, the "Playhead," moves across the waveform to 
indicate the location in the sound file that is being heard (see Figure 3).

Figure 3 – The Playhead

When you first open an image file, playback will start from the left edge of the 
audio. The Playhead will move to the right, across the audio. When you hit the 
Space Bar again, playback ends and the Playhead stops moving. When you hit 
the Space Bar a third time, the Playhead will jump back to the left side of the 
waveform display, the beginning of the sound file, and playback will start again.

3.2.1.1  Play from Edit Point

When you click anywhere inside the waveform display, the entire Panel or win-
dow containing the waveform display is selected. The selected Panel has a 
medium blue background and thin red line framiong the Panel. Once selected, 
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ant click in that Panel produces a vertical red line, with an inverted yellow trian-
gle on top. This is the Edit Point (see Figure 4).

Figure 4 – The Edit Point

When the Edit Point is present, playback will start from the Edit Point. When you 
stop playback and start again, the Playhead will jump back to the Edit Point and 
start playback from there.

You can move the Edit Point by clicking on a new location in the waveform dis-
play. The Edit Point will jump to the cursor location. Alternatively, you can click 
and drag the yellow triangle to move the Edit Point to a new location.

3.3  Navigating the Waveform Display

There are many tools for quicky moving around inside of the waveform display.

3.3.1  Scrolling

If you are zoomed all the way out, the entire waveform will be displayed. If you 
are not zoomed out all of the way, some of the waveform will be off the edge of 
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the Panel. You can move the window view left or right by moving the slider 
control at the bottom of the waveform display (see Figure 5).

Figure 5 – The timeline view slider

You can also move the window view left and right by using the Left Arrow key 
and the Right Arrow key.

3.3.2  Zooming

You can zoom in using the Down Arrow key, and zoom out using the Up Arrow 
key. To zoom all the way out, hit the "E" (for "entire") key.

3.3.2.1  Zoom around Edit Point

As you zoom in and out, it is likely that you will want to keep the Edit Point in 
view. To do this, hold down the Apple or command (a) key as you use the Up 
Arrow or Down arrow keys. This will keep the Edit Point centered in the middle 
of the display.

3.3.2.2  Zoom to Selection

Clicking and dragging on the waveform selects a region, highlighted in yellow 
features (see section 3.4.1, Selecting a Region).. Typing command-G (a-G) or 
selecting View > Zoom to Selection will zoom around the selected region.

3.3.2.3  Zoom around time selection

If you click and drag in the black timeline banner above the top Panel while 
holding down the command key, the Panel will zoom to display the region of 
the timeline that your click–and–drag defined.

Slider control
Timebase control
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3.4  Selections

Selections let you highlight a portion of the audio where you want to perform cer-
tain operations.

3.4.1  Selecting a Region

To select a region, click on the waveform display at the point that you want the 
selection to start and, while holding down the mouse button, drag right to where 
you want the Selection to stop. An area will be highlighted in yellow to indicate 
the selected region (see Figure 6).

Figure 6 – Using Selection to highlight a region

You can also click to define where you want the selection to end, then drag left to 
where you want the slection to end. 

You can fine tune the boundaries of a selected region. Hold down the Shift key 
and click on either side of the Selection to expand the Selection. You can also 
Shift–drag on either side of the Selection to expand or contract the Selection.

◊ Note – At the top of the main window, the LEFT, RIGHT and DUR fields are 
active and editable. A single click in any of the HH:MM:SS:FF segments of these 
time fields will highlight that segment, allowing you to type in a value. By clicking 
and dragging up or down, the cursor will change to an arrow and you can cause 
the value displayed to increase or decrease, respectibvely. Double clicking in any 
of these three ftime fields will select the entire field , allowing you to enter a 
complete time code address.

3.4.2  Selecting the entire sound file

The entire sound file can be chosen as a Selection. Click on the white bar that is at 
the top of the waveform display. The yellow bar will appear, running the entire 
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length of the sound file, to indicate that the sound file has been Selected (see 
Figure 7).

Figure 7 – Selecting the entire sound file

3.5  PQ Marks
PQ marks are indicated in the black area right above the waveform display (see 
Figure 8).

Figure 8 – PQ marks

Start marks are indicated by a triangle pointing right. End marks are indicated by a 
triangle pointing left. Index marks are indicated by a tringle pointing down.
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3.5.1  Inserting PQ marks

To insert a new PQ mark: (1) Place the Edit Point at the location where you want 
the new mark. (2) Go to the EDL menu, and select New Mark and then Start, End, 
or Index (see Figure 9).

Figure 9 – Inserting a PQ mark

3.5.2  Moving PQ marks

It is easy to slide the PQ marks from one location to another. Just hold down the 
Option key, and click on the mark and drag it (see Figure 10).

Figure 10 – Relocating a PQ mark
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3.5.3  Removing PQ marks

To remove PQ marks: (1) Select a region that includes the marks you want to 
remove. (2) Hold the Command key and hit the F12 key (see Figure 11).

Figure 11 – Deleting a mark

3.5.3.1  The Mark Info window

The Track Info window has 2 tabs. The first tab displays the Mark Info window. This
is a listing of all of the numerical values associated with the PQ marks, along with
some other album information and special flags. The second tab displays the PQ
Delivery window. This window allows information to be written to the DDP image.
It also has provisions for printing reports.
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3.6  The PQ Info tab of the Mark Info window

Figure 12 shows the PQ Info tab of the Mark Info window.

Figure 12 – The Mark Info window’s PQ Info tab 

3.6.1  PQ Offsets

Offsets are often applied to some PQ marks. This area of the window is for 
adjusting the offsets.
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◊ Note – As a rule, the proper offsets were most likely applied during the delivery 
of the original DDP image. That is why SonicStudio•DDP uses a default of zero for 
the offsets.

Since the offsets were added to the PQ mark times on delivery, it is impossible to 
separate the offsets back out when editing the DDP image.

3.6.1.1  Display with Offsets button

PQ Mark times are displayed at the bottom of the window. If this button is 
selected, the times will be displayed with the offsets added in.

3.6.1.2  Disable Offsets

If this button is selected, the offsets shown in the offset windows will not be fac-
tored into the PQ mark times, either for display or for delivery.

3.6.1.3  Start Offset

It takes a typical CD player between two and twenty frames to start producing 
sound after it has located the Track Start Mark and filled its memory buffer. The 
Start Offset ensures that the beginning of the track will not be clipped by the 
player.

3.6.1.4  End Offset

The End Offset prevents the player from muting too early at the end of the track. 
This offset value applies to the End Marks, including the last End Mark.

3.6.1.5  Splice Offset

If a Start Mark is not preceeded by an End Mark from the previous track, it is 
considered to be a "splice". This offset applies only to splice Start Marks. The 
Splice Offset must always be shorter than the Start Offset.

3.6.1.6  Track 1 Offset

This setting allows the Start of Track Mark for Track 1 to have it’s own offset 
value.

3.6.1.7  UPC/EAN Code

This is the product’s Universal Product Code/European Article Number barcode. 
UPC/EAN barcodes are 13 digits and, in the United States, the leading digit 
should be set to a zero.  This number can be stored in the DDP image and, if 
present, is recalled by SonicStudio•DDP.
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3.6.2  Mark Type and Location

This section displays information on one mark at a time. The mark that is 
diplayed is the mark that is selected in the lower section of the PQ info window 
(see section 5, Tips and Tricks).

3.6.2.1  Track Name

The unlabeled text field directly under "Mark Type and Location" is the name of 
the selected PQ mark.

There are no mark names stored in a DDP image. The mark names here are only 
used and saved in a Project file.

When a DDP image is first loaded, SonicStudio•DDP assigns default names to 
the marks. The Start Marks are numbered, and called Track 1, Track 2, Track 3, etc. 
The End Marks and Index Marks are not numbered, and are called End and 
Index, respectively.

You can assign your own names to the marks. Just select a mark in the list at 
the bottom of the window, and type a new name into this box. The new maker 
name will appear in the list at the bottom of the PQ Info window, and also next 
to the marks above the waveform display. These names will be saved and 
recalled in a Project.

3.6.2.2  Type

This pop-up indicates whether the mark is a Start Mark, End Mark, or Index 
Mark. You can change the mark type by clicking on the up/down arrow and 
selecting a different mark type.

3.6.2.3  Time

This box displays the time location of the selected mark.

3.6.2.4  Lock button

This button locks all attributes of the selected mark.

3.6.2.5  Offset

This field shows the offset, if any, that applies to the selected mark. If the default 
offset is not used, you can enter a custom offset for this mark.

3.6.2.6  Default button
13



                   
This button determines where the default offset, if any, applies to the mark or a 
custom value will be used instead.

3.6.2.7  ISRC Code

This field shows the ISRC Code, if any, that is associated with the selected Start 
of Track Mark.

3.6.2.8  Copy Enabled Button

This button shows and controls the state of the Copy Enable metadata bit. 
Copying is enabled when the  button is red.

3.6.2.9  Emphasis Flag Button

This button shows and controls the state of the Emphasis Flag metadata bit. 
When the Emphasis Flag is set, the player will de–emphasize the track on play-
back. The Emphasis flag is set when the button is red.

3.6.3  PQ Log and Track Info

3.6.3.1  Total Tracks

This field shows the total number of Start Marks that will appear on the CD.

3.6.3.2  Total Time

This field shows the total playing time of the CD.

3.6.3.3  PQ and Track listing

This field shows a list of all marks present. For Start Marks, the line shows the 
track number, the track name, the start and end time, along with the duration. 
End of Track and Index Marks are also listed, along with their time location.

Any individual mark can be selected by clicking on that row in the list. A 
selected track is highlighted in yellow while information on the highlighted 
mark will appear in the fields above within the Mark Type and Location section 
(see section 3.6.2, Mark Type and Location). 

3.6.3.4  PQ Information Valid indicator

SonicStudio•DDP checks to see that all PQ marks conform to the Red Bood 
specificatio. If they meet the requirements, the indicator at the lower left corner 
will be green and a message will say "PQ Information is valid." If the PQ marks 
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violate the Red Book requirements, the button will be yellow, and a message 
will appear describing what is wrong with the mark parameters.

3.7  PQ Delivery tab of the Mark Info window

Figure 13 shows the PQ Delivery tab of the Mark Info window.

Figure 13 – The PQ Delivery tab of the Mark Info window

3.7.1  Write PQ Info

This check box forces SonicStudio•DDP to write new PQ metadata into the newly 
created DDP image file set based on the infomation entered in the PQ Info 
window.

3.7.2  Copy Audio File

This check box forces SonicStudio•DDP to copy the audio files into the newly 
created DDP image file set.

3.7.3  Execute button

This button causes a new DDP image file set, along with the options selected in 
the two check boxes, discussed in sections 3.7.1 and 3.7.2  above, to be written to 
disk at the location shown in the Path: field. When you click the Execute button, a 
standard file browser dialog opens, allowing you to specify the location that will 
be used. A new folder should be specified to contain the newly created DDP 
image file set.
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Once the destination is specified, SonicStudio•DDP begins the process of 
creating the new file set, with progress shown in the status field at the bottom of 
the PQ Delivery window.

◊ Note – Changes made anywhere in SonicStudio•DDP will not be incorporated 
into a DDP image file set until the delivery is executed.

3.7.4  Track List

This button generates a text file listing tracks, start times, end times and duration 
(see Figure 14).

Figure 14 – A Track List
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3.7.5  Export List

This button generates a Source Export List (see Figure 15).

Figure 15 – A Source Export List
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3.7.6  PQ List

This button generates a PQ List (see Figure 16).

Figure 16 – A PQ List
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4  Menus

4.1  File menu

Figure 17 shows the File menu.

Figure 17 – The File menu

4.1.1  Open DDP Image…

This command opens the DDP Image that you are going to audition or edit. If you 
open a DDP image, you are opening an entire set of files in their enclosing folder, 
not a single file.

Remember that any edits you make will not automatically be copied into the DDP 
image file. To make changes in the DDP image file, you have to execute a Delivery 
in the Mark Info window.

4.1.2  New Project

If you are currently displaying a Project, and you want to start another at the 
same time, select New Project. It will open a new empty waveform display 
window over the top of the existing one.

If you move the new waveform display window, you can see the windows of 
both Projects. So, you can go back and forth between two (or more) projects.

The Mark Info window will display information for the Project which has the 
active waveform display window.

There is also a list of active Projects at the bottom of the Windows menu. You can 
use this list to select the active Project.

4.1.2.1  Opening Standalone DDPi Audio Files 
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SonicStudio•DDP is able to open the audio files that accompany DDPi file sets, 
without their associated metadata files. Files named IMAGE.DAT and 
IMAGE.TRK will be recognized, as well as audio files with a file type of 
“IMAGE.”

To open these files as stand–alone, simply drag and drop the file into the top 
(Left) panel of a new, empty Project. SonicStudio•DDP will automatically place 
the sound file head on the timeline starting at 2 seconds.

4.1.3  Open Project

A Project is usually a work in progress. A Project file lets you save your editing 
work in a file, separate from the DDP image files, along with all the editing meta-
data you added to the Project such as SRP’s. An additional feature of a Project is 
that you can save your edits decisions without commiting them back to the DDP 
image file.

All edits are non–destructive. The Project file saves the segment names, PQ 
marks, and edits.

4.1.4  Close Window

This command closes the most recently selected active window. This can be a 
Project window, a Mark Info window, a Status window, or a Preferences window. 
Except for a Project window, if you close a window, you can reopen it  by going 
to the Windows menu and selecting it.

4.1.5  Save Project

This will save the current state of the active Project. It is saved with its current 
name and path. This command will overwrite any previously saved Project file 
with that name and path.

◊ Note – Save Project does not update the DDP image. To update the DDP image 
file, you must execute a Delivery (see Section 3.7.3, “Execute button”).

4.1.6  Save Project As

This command lets you save a copy of the active project under a new filename or 
path.

◊ Note – SonicStudio•DDP allows you to choose either a target or destination 
folder or, you can navigate into a folder. If the destination folder is empty, Sonic-
Studio•DDP simply writes the audio and/or metadata files as directed. If, 
however, the destination folder is not empty, SonicStudio•DDP alerts you that a 
potential conflict exists to overwrite files and asks for more information.
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4.1.7  Build Sound Waveform…

The DDP Image file includes sample values but does not contain the waveform–
specific data needed to draw the audio display. So, if you would like to have a 
waveform while auditioning or editing and unchecked the default preference to 
create waveforms when you opened the file, you must select the Build Sound 
Waveform… command.

First, you must select the sound file by clicking on the bar on the top of the wave-
form display. Clicking on the name of the image sound file, “IMAGE.DAT” for 
instance, is a good place to click on in order to select the sound file. The whole 
bar representing the sound file will turn yellow to show that it is selected. Then 
select the File > Build Sound Waveform… command.

4.1.8  Quit

The Quit button closes the SonicStudio•DDP application.

4.2  Edit Menu

4.2.1  Undo

The Undo command undoes the last command.

4.2.2  Redo

The Redo command reperforms the last command undone

4.2.3  Cut, Copy & Paste

The Cut, Copy and Paste commands move selected data into and out of the Clip-
board in standard Mac OS fashion.

4.2.4  Clear

The Clear command will delete a selected segment of audio.. See Section 4.1.7, 
“Build Sound Waveform…” above for more information about selecting a 
segment.

4.2.5  Select/Deselect All

These commands select or deselect all segements, that is, the entire soundfile.
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4.2.6  Delete Selection

If Edit Points are present, this command will delete the region defined by the Edit 
Points and move any audio after the Edit Points to the left to “ripple” or fill in the 
space formerly occupied by the audio within the Edit Points. See Section 4.6.3, 
“Set In & Out Points” for more information about Edit Points.

4.2.7  Clear Selection

If Edit Points are present, this command will delete the region defined by the Edit 
Points Unlike the Delete Selection command (see Section 4.2.6, “Delete Selec-
tion” above), this command does not move any audio but instead leaves a gap 
formerly occupied by the audio within the Edit Points. See Section 4.6.3, “Set In & 
Out Points” for more information about Edit Points.

4.2.8  Edit Segment Name

The  Edit Segment Name command allows you to change the name of the 
selected segment. After selecting a segment and involking the Edit Segment 
Name command, the Segment Name label in the upper left corner of the selected 
segment will highlight, allowing you to type in a new name. To complete the 
process, either hit the Enter key or click outside of the selected segement.

4.3  EDL menu

Figure 18 shows the EDL menu.

Figure 18 – The EDL menu

4.3.1  Mark Info

The Mark Info commend brings the Mark Info window to the front.
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4.3.2  New Mark

The New Mark command drops a PQ Mark at the Edit Point location. When you 
select New Mark, a submenu appears, allowing you to select a Start of Track, End 
of Track or Index Mark (see Figure 19).

Figure 19 – The New Mark submenu

4.3.3  Delete Mark

The Delete Mark command is used to remove PQ Marks. If a region is selected in 
the waveform display, all of the PQ Marks that are within the selected  time 
region are deleted. If no region is selected, this command will remove a PQ Mark 
if the Edit Point is at the exact time location of a single mark (see section 4.6.11, 
Move to Next Mark).

4.3.4  Lock Marks from Selection

This command uses a selected region to indicate which PQ Marks to be locked. 
Once locked, the PQ Marks cannot be changed until they are unlocked.

4.3.5  Unlock Marks from Selection

This command uses a selected region to indicate which PQ Marks to be unlocked. 
Once unlocked, the PQ Mark’s parameters can be altered.

4.3.6  Lock All Marks

This command locks all PQ Marks on the timeline. Once locked, the PQ Marks 
cannot be altered until they are unlocked

4.3.7  Unlock All Marks

This command unlocks all PQ marks on the timeline.
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4.3.8  Refresh EDL

The Redraw EDL command redraws the Project window.

4.4  Track Menu

Figure 20 shows the Track Menu.

Figure 20 – The Track menu

4.4.1  Display Track As

You can use Display Track As command to switch between showing audio wave-
forms and showing a time–only “bar” display. When you click on Display Track 
As, a submenu appears (see Figure 21). In this submenu, you can choose wave-
form or bar.

Figure 21 – The Display Track As command with submenu

4.4.2  Select All Tracks

With this command, all tracks can be selected. When a track is selected, it indi-
cates that certain operations will happen only on that track and other that are 
selected, but not on track which are not selected. For example, the Solo menu 
command will only work on selected tracks.
24



A track can be selected by clicking inside the track. When a track is selected, the 
background of the track changes to a lavender color.

Since SonicStudio•DDP is a stereo–only application, the Select All Tracks 
command causes both tracks to be selected.

4.4.3  Deselect All Tracks

This command causes both tracks to not be selected.

4.4.4  Mute Track

This command mutes the selected track(s). The Mute button on that track will turn 
green.

4.4.5  Solo Track

This command solos the selected track(s). The Solo button on that track will turn 
green.

4.5  The Play menu

Figure 22 shows the Play menu.

Figure 22 – The Play menu

4.5.1  Play From Selection

This command starts playback from the beginning of a selected region.
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4.5.2  Play Selection

This command plays a selected region.

4.5.3  Play From Playhead

In normal operation, when you hit the Space Bar to start playback, the Playhead 
will jump to the Edit Point or, the start of the file if there is no Edit Point, and 
begin playback . However, when you choose Play From Playhead, the Playhead 
stays in the location where it last stopped, and playback begins there.

4.5.4  Loop

If there is a selected region, SonicStudio•DDP will repeatedly play the region. If 
there is not a selected region, SonicStudio•DDP will repeatedly play the entire 
sound file.

Repeat playback continues until you stop play with the menu command or by 
hitting the Space Bar.

4.5.5  Stop All

This command stops playback.
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4.5.6  Around Selection Center

This command plays a section of sound in the center of a selected region. When 
you choose Play Around Selection Center, a submenu appears (see Figure 23.

Figure 23 – Play Around Selection Center

In the submenu, select the length of playback time from the six choices.

4.5.7  Play from Selection

Like Play Around Selection Center above, this command requires you to first 
select a region. This command  will play the selected amount of time starting at 
the beginning of the selected region, if there is one. If there is not a selected 
region, it will play starting at the Edit Point.

4.5.8  Play to End of Selection

This command is the same as Play from Selection (see section 4.5.7, Play from 
Selection), except that the playback ends at the trailing edge (right side) of a 
selected region, if there is one. If there is not a selected region, playback ends at 
the Edit Point.

4.5.9  Play To In Point

This command plays a section of sound up to the In Point. The length of playback 
is set in the Preferences window (see section 6.2, Time Display Preferences).
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4.5.10  Play From In Point

This command plays a section of sound starting at the In Point. The length of 
playback is set in the Preferences window (seesection 6.2, Time Display Prefer-
ences ).

4.5.11  Play To Out Point

This command plays a section of sound up to the Out Point. The length of play-
back is set in the Preferences window (see section 6.2, Time Display Preferences).

4.5.12  Play From Out Point

This command plays a section of sound starting at the Out Point. The length of 
playback is set in the Preferences window (see section 6.2, Time Display Prefer-
ences).

4.5.13  Play Between In and Out Points

This command starts playback at the In Point and continues to the Out Point.

4.5.14  Move Playhead

This command lets you place the playhead at a specific time location. When you 
select this menu item, a window pops up (see Figure 24). When you type in a new 
time and hit Enter, the Playhead will jump to the new location.

Figure 24 – The Move Playhead window

◊ Note – The Playhead can also be moved by dragging it with the mouse (see 
section 5, Tips and Tricks).

4.5.15  Hide Playhead When Stopped

When this is chosen, the Playhead is only visible during playback. A checkmark 
appears next to this menu item when it is selected.
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4.6  Selection menu

Figure 25 shows the Selection menu.

Figure 25 – The Selection menu

4.6.1  Set In Point

In and Out Points are special marks you can place in the waveform display. An In 
Point is shown as a vertical line with a triangle at the bottom, pointing right. On 
an Out Point, the triangle is pointing left (see Figure 26).

Figure 26 – In Point and Out Point

There can only be one In Point and one Out Point.

If both an In Point and Out Point is present and, if the In Point is to the left of the 
Out Point on the waveform display, then the area between the In and Out Point 
will be highlighted in yellow. The Set In Point command drops an In Point at the 
location of the Edit Point.

◊ Note – The IN, OUT and DUR time fields at the top right of the main Project 
window are always active and fully editable. These fields allow you to precisely 
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alter the location of, and duration between, the In and Out Points. See 
section 3.4.1, Selecting a Region for more information on editing time test fields.

4.6.2  Set Out Point

This command drops an Out Point at the location of the Edit Point.

4.6.3  Set In & Out Points

If there is a selected region on the waveform display, then this command will 
create an In Point at the start of the selected region, and an Out Point at the end 
of the selected region.

4.6.4  Clear In Point

This command will remove the In Point from the waveform display.

4.6.5  Clear Out Point

This command will remove the Out Point from the waveform display.

4.6.6  Clear In & Out Points

This command will remove both the In Point and the Out Point from the wave-
form display.

4.6.7  Nudge Right/Left

These commands makes it easy to move an In and/or Out Point slightly to the 
right or left. When you select this command, a submenu comes up asking 
whether you want to move an In Point, an Out Point, or both (see Figure 27).

Figure 27 – The Nudge Right command

The amount that the Point(s) is determined by a setting in the Preferences 
window‘s Time Display tab  (see section 6.2, Time Display Preferences).
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4.6.8  Move In Point…/Move Out Point…

When you select Move In Point… or Move Out Point…, it brings up a modal 
window (see Figure 28).

Figure 28 – The Move In Point window

By clicking on the "Where" button, you can load the time of the Playhead, the In 
Point, or the Out Point. By clicking on the "SRP" button, you can load the time 
value of any of the SRP’s. Or you can manually type a new time value into the 
timetext field. Then, when you click on the "Move" button, the In Point or Out 
Point jumps to the new time location you entered.

4.6.9  Move In Point to Out Point

This command makes the In Point jump to the location of the Out Point, and the 
Out Point is removed.

4.6.10  Find & Set Points

This command places an In Point at the beginning of the sound file, and an Out 
Point at the end of the sound file.

4.6.11  Move to Next Mark

This command moves the Edit Point to the location of the next mark to the right 
on the timeline.

4.6.12  Move to Previous Mark

This command moves the Edit Point to the location of the closest adjacent mark 
to the left on the timeline.
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4.7  View menu

Figure 29 shows the View menu.

Figure 29 – The View menu

4.7.1  Move Forward / Move Backward

If you are zoomed in such that not all of the waveform in showing in the display, 
some of the waveform will be out of view to the sides of the display. These 
commands let you move the time window to the left or right to bring the desired 
section of the waveform into view.

4.7.2  Zoom In/Zoom Out

The zoom commands change the time scale by 90%. Zoom in lets you see the 
waveform display in more detail. Zoom out lets you see more of the total sound 
file on the display.
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4.7.3  Zoom In around Playhead/Zoom Out around 
Playhead

These commands change magnification based on Playhead location and are very 
handy because they keeps the waveform display centerd around the Playhead as 
you zoom in or out.

4.7.4  Zoom to Previous/Zoom to Next

These commands are like undo / redo commands for zoom level. Sonic-
Studio•DDP remembers recent zoom levels. To return to an earlier zoom level, 
choose Zoom to Previous. To return to a later zoom lever, choose Zoom to Next.

4.7.5  Zoom around Playhead

This command zooms with the Playhead in the center of the waveform display. 
The level of zoom is determined by a submenu (see Figure 30). For instance, if 
you choose 1 second, there will be approximately one second of time displayed 
in the waveform display, centered on the current location of the playhead.

Figure 30 – Zoom around Playhead

4.7.6  Zoom around Selection Center

This command is similar to Zoom around Playhead, except that the display is 
centered around the centerpoint of a selected region or selected segment.

4.7.7  Zoom to In Point/Out Point

This command zooms with the In or Out Point centered on the waveform display. 
The level of zoom is determined by the setting in the Preferences window.
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4.7.8  Zoom to Selection Start/End

This command zooms with the selection start or the selection end centered on 
the waveform display. The level of zoom is determined by the setting in the Pref-
erences window (see section 6.2, Time Display Preferences).

4.7.9  Zoom to Selection

This command zooms so that the selection is centered on the waveform display 
window and covers a certain percentage of the waveform display area, 
depending on a setting in the Preferences window (see section 6.2, Time Display 
Preferences).

4.7.10  Zoom to Entire EDL/Entire Track

Since there is a single stereo sound file displayed, these two menu commands 
are the same. These commands zoom so that the entire sound file is shown 
across the width of the waveform display area.
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5  Tips and Tricks
In checking out the accuracy of a PQ Mark placement, it is often best to have audition 
modes that will play a short section of sound up to a PQ Mark and stop, or to start 
playback of a short section of sound starting at a PQ Mark.

5.1  Play To/From using the Edit Point

First, place the Edit Point at the desired PQ Mark. This can be done easily with the 
Move to Next Mark command and the Move to Previous Mark command (see 
4.6.11). The keys for these commands are F6 and F7, respectively.

Once the Edit Point is coincident with a PQ Mark, you can use the Play from Selec-
tion command and the Play to End of Selection commands to play from or to the 
PQ Mark, respectively (see section 4.5.7, Play from Selection and section 4.5.8, Play 
to End of Selection). There are no key commands for these two Play modes.

5.2  Play To/From using an In Point

If you would like the convenience of doing the auditioning with a key command, 
drop an In Point at the PQ Mark (see section 4.6.1, Set In Point).

To play up to the PQ Mark, after placing an In Point, use the Play To In Point Com-
mand, which is F5. To play from the mark. use the Play From In Point command, 
which is F6
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6  The Preferences window
The Preferences window lets you fine tune SonicStudio•DDP for your individual 
style of work.

6.1  Editing Tools Preferences

Figure 31 shows the Preferences window for Editing Tools.

Figure 31 – Preferences window for Editing Tools

6.1.1  Playing Auto Tools

If you do not check either box in this section, the waveform display will stay 
stationary, and the Playhead will be allowed to go off the screen.

6.1.1.1  AutoScroll Playhead

If you select this box, the Playhead will move from left-to-right on the waveform 
display until it gets to the right edge. Then, the waveform display will jump for-
ward on the timeline to allow the Playhead to stay in view. The Playhead will 
continue scrolling from left to right.

6.1.1.2  AutoScroll Track

If you select this box, the Playhead will stay in the center of the waveform dis-
play, and the waveform will move from right to left, emulating a fixed playback 
head on a tape transport.
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6.1.2  Display Auto Tools

6.1.2.1  AutoScale On

This feature scales the waveform display so that the peak value of the wave-
form fills the height of the waveform display window. In other words, it 
increases the size of the waveforms for low amplitude sound files to make 
details more visible.

6.1.2.2  Scale to View

If this is selected, the AutoScale feature scales the waveform according to the 
maximum signal level in the current waveform display on view. If it is not 
selected, it scales based on the maximum signal level on the track, even if it is 
out of view.

6.1.2.3  Show Track Scale in dB

If this box is checked, the waveform display will be calibrated in dB relative to 
full scale or 0 dBfs. If the box is not checked, the waveform display will be cali-
brated in a normailized, dimensionless, linear value, with full scale equal to 1.

6.1.2.4  Show Subframes

If this box is checked, all of the time displays at the top of the main window add 
a decimal point and two digits to show subframes based on Time Display pref-
erences (see  Section 6.2.1, “Default Time Display” below).
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6.2  Time Display Preferences

Figure 32 shows the Preferences window for Time Display.

Figure 32 – Time Display Preferences

6.2.1  Default Time Display

When you open a New Project, it will set the main window to display time based 
on this setting. The time format can be changed using a pull-down menu at the 
bottom left side of the main window (see Section Figure 5, “– The timeline view 
slider” above.

6.2.2  Nudge A/B/C

When you nudge the In or Out Point via the Selection menu, SonicStudio•DDP 
uses the Nudge B value to define how much to move the Edit Point. The Nudge A 
and Nudge C values are inactive.

6.2.3  Zoom to In/Out Points

This is the amount of time showing in the waveform display when you zoom to 
an In Point or an Out Point.

6.2.4  Zoom to Sel Start/

This preference is inactive.
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6.2.5  Play around In/Out Point

This preference controls the pre and postroll for the Play > Play To/From Edit 
Points commands.

6.3  EDL Preferences

Figure 33 shows the Preferences window for EDLs and Projects.

Figure 33 – EDL Preferences

6.3.1  Show Segment Names

This preference determines whether the sound file name is displayed at the top 
left corner of the waveform display. In a DDP file, the default name is 
“IMAGE.DAT.”

6.3.2  Background Waveforms

This preference forces SonicStudio•DDP to calculate and display waveforms in 
the background for file sets that do not already include this data.

6.3.3  Remove Waveforms on close

For file sets that include Sonic Studio waveform data, this preference forces 
SonicStudio•DDP to delete the waveform files when the application is shut down.
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6.3.4  Zoom Factor

When zooming to a selection, this preference determines how much of the 
display is taken up with the selected region. If it is set at 100%, the selected 
region will fill the entire width of the waveform display. The default setting of 90% 
means that there will be 5% “overlap” shown on ether side of the selction, which 
provides some visual context for the zoomed region.

041214SonicSDDPUMv6OM
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	1 Overview
	SonicStudio•DDP is an easy to operate, task-specific tool for working with DDP image files.
	1.1 Workflow
	When you open a DDP image into SonicStudio•DDP, you are creating a copy of the image in memory th...
	Within the Project, you can edit marks that generate PQ codes, and you can also place editing mar...
	× Note – None of your changes to the Project are saved to the DDP image until you intentionally w...


	2 The Main Screen
	Figure�1 shows the main screen of SonicStudio•DDP.
	Figure 1 – The main window
	The bottom of the screen shows the waveform display for the two tracks of audio. The upper wavefo...
	Immediately above the wavefoms is a black banner. At the top of the black area is the timeline fo...
	To the left of each track are solo and mute buttons, labeled with an S and M respectively, along ...

	3 Quick Start
	This section tells you how to use the most basic operations so you‘ll be up and running right awa...
	3.1 Opening A File
	3.1.1 Opening a Project or DDP Image
	Figure 2 - Waveforms being built in the background
	3.2 Auditioning Sound

	3.2.1 Playback
	When you press the Space Bar, the cursor changes to a speaker & note as playback will start. A ve...
	Figure 3 – The Playhead
	When you first open an image file, playback will start from the left edge of the audio. The Playh...

	3.2.1.1 Play from Edit Point
	When you click anywhere inside the waveform display, the entire Panel or window containing the wa...
	Figure 4 – The Edit Point
	When the Edit Point is present, playback will start from the Edit Point. When you stop playback a...
	You can move the Edit Point by clicking on a new location in the waveform display. The Edit Point...
	3.3 Navigating the Waveform Display
	There are many tools for quicky moving around inside of the waveform display.


	3.3.1 Scrolling
	If you are zoomed all the way out, the entire waveform will be displayed. If you are not zoomed o...
	Figure 5 – The timeline view slider
	You can also move the window view left and right by using the Left Arrow key and the Right Arrow ...

	3.3.2 Zooming
	You can zoom in using the Down Arrow key, and zoom out using the Up Arrow key. To zoom all the wa...

	3.3.2.1 Zoom around Edit Point
	As you zoom in and out, it is likely that you will want to keep the Edit Point in view. To do thi...

	3.3.2.2 Zoom to Selection
	Clicking and dragging on the waveform selects a region, highlighted in yellow features (see secti...

	3.3.2.3 Zoom around time selection
	If you click and drag in the black timeline banner above the top Panel while holding down the com...
	3.4 Selections
	Selections let you highlight a portion of the audio where you want to perform certain operations.


	3.4.1 Selecting a Region
	To select a region, click on the waveform display at the point that you want the selection to sta...
	Figure 6 – Using Selection to highlight a region
	You can also click to define where you want the selection to end, then drag left to where you wan...
	You can fine tune the boundaries of a selected region. Hold down the Shift key and click on eithe...
	× Note – At the top of the main window, the LEFT, RIGHT and DUR fields are active and editable. A...

	3.4.2 Selecting the entire sound file
	The entire sound file can be chosen as a Selection. Click on the white bar that is at the top of ...
	Figure 7 – Selecting the entire sound file
	3.5 PQ Marks
	PQ marks are indicated in the black area right above the waveform display (see Figure�8).
	Figure 8 – PQ marks
	Start marks are indicated by a triangle pointing right. End marks are indicated by a triangle poi...


	3.5.1 Inserting PQ marks
	To insert a new PQ mark: (1) Place the Edit Point at the location where you want the new mark. (2...
	Figure 9 – Inserting a PQ mark

	3.5.2 Moving PQ marks
	It is easy to slide the PQ marks from one location to another. Just hold down the Option key, and...
	Figure 10 – Relocating a PQ mark

	3.5.3 Removing PQ marks
	To remove PQ marks: (1) Select a region that includes the marks you want to remove. (2) Hold the ...
	Figure 11 – Deleting a mark

	3.5.3.1 The Mark Info window
	3.6 The PQ Info tab of the Mark Info window
	Figure 12 – The Mark Info window’s PQ Info tab


	3.6.1 PQ Offsets
	Offsets are often applied to some PQ marks. This area of the window is for adjusting the offsets.
	× Note – As a rule, the proper offsets were most likely applied during the delivery of the origin...
	Since the offsets were added to the PQ mark times on delivery, it is impossible to separate the o...

	3.6.1.1 Display with Offsets button
	PQ Mark times are displayed at the bottom of the window. If this button is selected, the times wi...

	3.6.1.2 Disable Offsets
	If this button is selected, the offsets shown in the offset windows will not be factored into the...

	3.6.1.3 Start Offset
	It takes a typical CD player between two and twenty frames to start producing sound after it has ...

	3.6.1.4 End Offset
	The End Offset prevents the player from muting too early at the end of the track. This offset val...

	3.6.1.5 Splice Offset
	If a Start Mark is not preceeded by an End Mark from the previous track, it is considered to be a...

	3.6.1.6 Track 1 Offset
	This setting allows the Start of Track Mark for Track 1 to have it’s own offset value.

	3.6.1.7 UPC/EAN Code
	This is the product’s Universal Product Code/European Article Number barcode. UPC/EAN barcodes ar...

	3.6.2 Mark Type and Location
	This section displays information on one mark at a time. The mark that is diplayed is the mark th...

	3.6.2.1 Track Name
	The unlabeled text field directly under "Mark Type and Location" is the name of the selected PQ m...
	There are no mark names stored in a DDP image. The mark names here are only used and saved in a P...
	When a DDP image is first loaded, SonicStudio•DDP assigns default names to the marks. The Start M...
	You can assign your own names to the marks. Just select a mark in the list at the bottom of the w...

	3.6.2.2 Type
	This pop-up indicates whether the mark is a Start Mark, End Mark, or Index Mark. You can change t...

	3.6.2.3 Time
	This box displays the time location of the selected mark.

	3.6.2.4 Lock button
	This button locks all attributes of the selected mark.

	3.6.2.5 Offset
	This field shows the offset, if any, that applies to the selected mark. If the default offset is ...

	3.6.2.6 Default button
	This button determines where the default offset, if any, applies to the mark or a custom value wi...

	3.6.2.7 ISRC Code
	This field shows the ISRC Code, if any, that is associated with the selected Start of Track Mark.

	3.6.2.8 Copy Enabled Button
	This button shows and controls the state of the Copy Enable metadata bit. Copying is enabled when...

	3.6.2.9 Emphasis Flag Button
	This button shows and controls the state of the Emphasis Flag metadata bit. When the Emphasis Fla...

	3.6.3 PQ Log and Track Info
	3.6.3.1 Total Tracks
	This field shows the total number of Start Marks that will appear on the CD.

	3.6.3.2 Total Time
	This field shows the total playing time of the CD.

	3.6.3.3 PQ and Track listing
	This field shows a list of all marks present. For Start Marks, the line shows the track number, t...
	Any individual mark can be selected by clicking on that row in the list. A selected track is high...

	3.6.3.4 PQ Information Valid indicator
	SonicStudio•DDP checks to see that all PQ marks conform to the Red Bood specificatio. If they mee...
	3.7 PQ Delivery tab of the Mark Info window
	Figure 13 shows the PQ Delivery tab of the Mark Info window.
	Figure 13 – The PQ Delivery tab of the Mark Info window


	3.7.1 Write PQ Info
	This check box forces SonicStudio•DDP to write new PQ metadata into the newly created DDP image f...

	3.7.2 Copy Audio File
	This check box forces SonicStudio•DDP to copy the audio files into the newly created DDP image fi...

	3.7.3 Execute button
	This button causes a new DDP image file set, along with the options selected in the two check box...
	Once the destination is specified, SonicStudio•DDP begins the process of creating the new file se...
	× Note – Changes made anywhere in SonicStudio•DDP will not be incorporated into a DDP image file ...

	3.7.4 Track List
	This button generates a text file listing tracks, start times, end times and duration (see Figure...
	Figure 14 – A Track List

	3.7.5 Export List
	This button generates a Source Export List (see Figure�15).
	Figure 15 – A Source Export List

	3.7.6 PQ List
	This button generates a PQ List (see Figure�16).
	Figure 16 – A PQ List


	4 Menus
	4.1 File menu
	Figure 17 shows the File menu.
	Figure 17 – The File menu

	4.1.1 Open DDP Image…
	This command opens the DDP Image that you are going to audition or edit. If you open a DDP image,...
	Remember that any edits you make will not automatically be copied into the DDP image file. To mak...

	4.1.2 New Project
	If you are currently displaying a Project, and you want to start another at the same time, select...
	If you move the new waveform display window, you can see the windows of both Projects. So, you ca...
	The Mark Info window will display information for the Project which has the active waveform displ...
	There is also a list of active Projects at the bottom of the Windows menu. You can use this list ...

	4.1.2.1 Opening Standalone DDPi Audio Files
	SonicStudio•DDP is able to open the audio files that accompany DDPi file sets, without their asso...
	To open these files as stand–alone, simply drag and drop the file into the top (Left) panel of a ...

	4.1.3 Open Project
	A Project is usually a work in progress. A Project file lets you save your editing work in a file...
	All edits are non–destructive. The Project file saves the segment names, PQ marks, and edits.

	4.1.4 Close Window
	This command closes the most recently selected active window. This can be a Project window, a Mar...

	4.1.5 Save Project
	This will save the current state of the active Project. It is saved with its current name and pat...
	× Note – Save Project does not update the DDP image. To update the DDP image file, you must execu...

	4.1.6 Save Project As
	This command lets you save a copy of the active project under a new filename or path.
	× Note – SonicStudio•DDP allows you to choose either a target or destination folder or, you can n...

	4.1.7 Build Sound Waveform…
	The DDP Image file includes sample values but does not contain the waveform– specific data needed...
	First, you must select the sound file by clicking on the bar on the top of the waveform display. ...

	4.1.8 Quit
	The Quit button closes the SonicStudio•DDP application.
	4.2 Edit Menu

	4.2.1 Undo
	The Undo command undoes the last command.

	4.2.2 Redo
	The Redo command reperforms the last command undone

	4.2.3 Cut, Copy & Paste
	The Cut, Copy and Paste commands move selected data into and out of the Clipboard in standard Mac...

	4.2.4 Clear
	The Clear command will delete a selected segment of audio.. See Section 4.1.7, “Build Sound Wavef...

	4.2.5 Select/Deselect All
	These commands select or deselect all segements, that is, the entire soundfile.

	4.2.6 Delete Selection
	If Edit Points are present, this command will delete the region defined by the Edit Points and mo...

	4.2.7 Clear Selection
	If Edit Points are present, this command will delete the region defined by the Edit Points Unlike...

	4.2.8 Edit Segment Name
	The Edit Segment Name command allows you to change the name of the selected segment. After select...
	4.3 EDL menu
	Figure�18 shows the EDL menu.
	Figure 18 – The EDL menu


	4.3.1 Mark Info
	The Mark Info commend brings the Mark Info window to the front.

	4.3.2 New Mark
	The New Mark command drops a PQ Mark at the Edit Point location. When you select New Mark, a subm...
	Figure 19 – The New Mark submenu

	4.3.3 Delete Mark
	The Delete Mark command is used to remove PQ Marks. If a region is selected in the waveform displ...

	4.3.4 Lock Marks from Selection
	This command uses a selected region to indicate which PQ Marks to be locked. Once locked, the PQ ...

	4.3.5 Unlock Marks from Selection
	This command uses a selected region to indicate which PQ Marks to be unlocked. Once unlocked, the...

	4.3.6 Lock All Marks
	This command locks all PQ Marks on the timeline. Once locked, the PQ Marks cannot be altered unti...

	4.3.7 Unlock All Marks
	This command unlocks all PQ marks on the timeline.

	4.3.8 Refresh EDL
	The Redraw EDL command redraws the Project window.
	4.4 Track Menu
	Figure�20 shows the Track Menu.
	Figure 20 – The Track menu


	4.4.1 Display Track As
	You can use Display Track As command to switch between showing audio waveforms and showing a time...
	Figure 21 – The Display Track As command with submenu

	4.4.2 Select All Tracks
	With this command, all tracks can be selected. When a track is selected, it indicates that certai...
	A track can be selected by clicking inside the track. When a track is selected, the background of...
	Since SonicStudio•DDP is a stereo–only application, the Select All Tracks command causes both tra...

	4.4.3 Deselect All Tracks
	This command causes both tracks to not be selected.

	4.4.4 Mute Track
	This command mutes the selected track(s). The Mute button on that track will turn green.

	4.4.5 Solo Track
	This command solos the selected track(s). The Solo button on that track will turn green.
	4.5 The Play menu
	Figure 22 – The Play menu


	4.5.1 Play From Selection
	This command starts playback from the beginning of a selected region.

	4.5.2 Play Selection
	This command plays a selected region.

	4.5.3 Play From Playhead
	In normal operation, when you hit the Space Bar to start playback, the Playhead will jump to the ...

	4.5.4 Loop
	If there is a selected region, SonicStudio•DDP will repeatedly play the region. If there is not a...
	Repeat playback continues until you stop play with the menu command or by hitting the Space Bar.

	4.5.5 Stop All
	This command stops playback.

	4.5.6 Around Selection Center
	This command plays a section of sound in the center of a selected region. When you choose Play Ar...
	Figure 23 – Play Around Selection Center
	In the submenu, select the length of playback time from the six choices.

	4.5.7 Play from Selection
	Like Play Around Selection Center above, this command requires you to first select a region. This...

	4.5.8 Play to End of Selection
	This command is the same as Play from Selection (see section�4.5.7, Play from Selection), except ...

	4.5.9 Play To In Point
	This command plays a section of sound up to the In Point. The length of playback is set in the Pr...

	4.5.10 Play From In Point
	This command plays a section of sound starting at the In Point. The length of playback is set in ...

	4.5.11 Play To Out Point
	This command plays a section of sound up to the Out Point. The length of playback is set in the P...

	4.5.12 Play From Out Point
	This command plays a section of sound starting at the Out Point. The length of playback is set in...

	4.5.13 Play Between In and Out Points
	This command starts playback at the In Point and continues to the Out Point.

	4.5.14 Move Playhead
	This command lets you place the playhead at a specific time location. When you select this menu i...
	Figure 24 – The Move Playhead window
	× Note – The Playhead can also be moved by dragging it with the mouse (see section�5, Tips and Tr...

	4.5.15 Hide Playhead When Stopped
	When this is chosen, the Playhead is only visible during playback. A checkmark appears next to th...
	4.6 Selection menu
	Figure�25 shows the Selection menu.
	Figure 25 – The Selection menu


	4.6.1 Set In Point
	In and Out Points are special marks you can place in the waveform display. An In Point is shown a...
	Figure 26 – In Point and Out Point
	There can only be one In Point and one Out Point.
	If both an In Point and Out Point is present and, if the In Point is to the left of the Out Point...
	× Note – The IN, OUT and DUR time fields at the top right of the main Project window are always a...

	4.6.2 Set Out Point
	This command drops an Out Point at the location of the Edit Point.

	4.6.3 Set In & Out Points
	If there is a selected region on the waveform display, then this command will create an In Point ...

	4.6.4 Clear In Point
	This command will remove the In Point from the waveform display.

	4.6.5 Clear Out Point
	This command will remove the Out Point from the waveform display.

	4.6.6 Clear In & Out Points
	This command will remove both the In Point and the Out Point from the waveform display.

	4.6.7 Nudge Right/Left
	These commands makes it easy to move an In and/or Out Point slightly to the right or left. When y...
	Figure 27 – The Nudge Right command
	The amount that the Point(s) is determined by a setting in the Preferences window‘s Time Display ...

	4.6.8 Move In Point…/Move Out Point…
	When you select Move In Point… or Move Out Point…, it brings up a modal window (see Figure�28).
	Figure 28 – The Move In Point window
	By clicking on the "Where" button, you can load the time of the Playhead, the In Point, or the Ou...

	4.6.9 Move In Point to Out Point
	This command makes the In Point jump to the location of the Out Point, and the Out Point is removed.

	4.6.10 Find & Set Points
	This command places an In Point at the beginning of the sound file, and an Out Point at the end o...

	4.6.11 Move to Next Mark
	This command moves the Edit Point to the location of the next mark to the right on the timeline.

	4.6.12 Move to Previous Mark
	This command moves the Edit Point to the location of the closest adjacent mark to the left on the...
	4.7 View menu
	Figure 29 – The View menu


	4.7.1 Move Forward / Move Backward
	If you are zoomed in such that not all of the waveform in showing in the display, some of the wav...

	4.7.2 Zoom In/Zoom Out
	The zoom commands change the time scale by 90%. Zoom in lets you see the waveform display in more...

	4.7.3 Zoom In around Playhead/Zoom Out around Playhead
	These commands change magnification based on Playhead location and are very handy because they ke...

	4.7.4 Zoom to Previous/Zoom to Next
	These commands are like undo / redo commands for zoom level. SonicStudio•DDP remembers recent zoo...

	4.7.5 Zoom around Playhead
	This command zooms with the Playhead in the center of the waveform display. The level of zoom is ...
	Figure 30 – Zoom around Playhead

	4.7.6 Zoom around Selection Center
	This command is similar to Zoom around Playhead, except that the display is centered around the c...

	4.7.7 Zoom to In Point/Out Point
	This command zooms with the In or Out Point centered on the waveform display. The level of zoom i...

	4.7.8 Zoom to Selection Start/End
	This command zooms with the selection start or the selection end centered on the waveform display...

	4.7.9 Zoom to Selection
	This command zooms so that the selection is centered on the waveform display window and covers a ...

	4.7.10 Zoom to Entire EDL/Entire Track
	Since there is a single stereo sound file displayed, these two menu commands are the same. These ...


	5 Tips and Tricks
	In checking out the accuracy of a PQ Mark placement, it is often best to have audition modes that...
	5.1 Play To/From using the Edit Point
	First, place the Edit Point at the desired PQ Mark. This can be done easily with the Move to Next...
	Once the Edit Point is coincident with a PQ Mark, you can use the Play from Selection command and...

	5.2 Play To/From using an In Point
	If you would like the convenience of doing the auditioning with a key command, drop an In Point a...
	To play up to the PQ Mark, after placing an In Point, use the Play To In Point Command, which is ...


	6 The Preferences window
	The Preferences window lets you fine tune SonicStudio•DDP for your individual style of work.
	6.1 Editing Tools Preferences
	Figure�31 shows the Preferences window for Editing Tools.
	Figure 31 – Preferences window for Editing Tools

	6.1.1 Playing Auto Tools
	If you do not check either box in this section, the waveform display will stay stationary, and th...

	6.1.1.1 AutoScroll Playhead
	If you select this box, the Playhead will move from left-to-right on the waveform display until i...

	6.1.1.2 AutoScroll Track
	If you select this box, the Playhead will stay in the center of the waveform display, and the wav...

	6.1.2 Display Auto Tools
	6.1.2.1 AutoScale On
	This feature scales the waveform display so that the peak value of the waveform fills the height ...

	6.1.2.2 Scale to View
	If this is selected, the AutoScale feature scales the waveform according to the maximum signal le...

	6.1.2.3 Show Track Scale in dB
	If this box is checked, the waveform display will be calibrated in dB relative to full scale or 0...

	6.1.2.4 Show Subframes
	If this box is checked, all of the time displays at the top of the main window add a decimal poin...
	6.2 Time Display Preferences
	Figure 32 – Time Display Preferences


	6.2.1 Default Time Display
	When you open a New Project, it will set the main window to display time based on this setting. T...

	6.2.2 Nudge A/B/C
	When you nudge the In or Out Point via the Selection menu, SonicStudio•DDP uses the Nudge B value...

	6.2.3 Zoom to In/Out Points
	This is the amount of time showing in the waveform display when you zoom to an In Point or an Out...

	6.2.4 Zoom to Sel Start/
	This preference is inactive.

	6.2.5 Play around In/Out Point
	This preference controls the pre and postroll for the Play > Play To/From Edit Points commands.
	6.3 EDL Preferences
	Figure 33 – EDL Preferences


	6.3.1 Show Segment Names
	This preference determines whether the sound file name is displayed at the top left corner of the...

	6.3.2 Background Waveforms
	This preference forces SonicStudio•DDP to calculate and display waveforms in the background for f...

	6.3.3 Remove Waveforms on close
	For file sets that include Sonic Studio waveform data, this preference forces SonicStudio•DDP to ...

	6.3.4 Zoom Factor
	When zooming to a selection, this preference determines how much of the display is taken up with ...



